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WELCOME TO TRIALDIRECTOR 6

Welcome to TrialDirector®, trial presentation software for attorneys and litigation support 

professionals. TrialDirector helps you organize exhibits and depositions, prepare cases for trial, and 

enhance case presentations. Whether you’re working with documents, images, photographs, 

transcripts, video testimony, or animations, you can easily view, manage, and present them using 

TrialDirector.

This guide is divided into four main sections:

• Navigat ing in Tr ia lDi rector   – Shows you the modules and tabs within TrialDirector.

• Creat ing and Organiz ing Your Case  – Explains how to create a new case file and add items 
to your case.

• Prepar ing for  Tr ia l  – Details basic case preparation, including how to add markups to images, 
add issue codes to transcripts, create focused video clips from transcripts, and use workbooks 
to organize exhibits.

• Present ing at  Tr ia l  – Introduces the Presentation mode and explains how to retrieve exhibits, 
mark up exhibits, and display video clips.

Other Resources

This guide provides a basic introduction to TrialDirector. Check out our other valuable resources 

to help you tap into the powerful features of the program:

• Tutorials – Free tutorials are available on inData’s Web site (www.indatacorp.com).

• Help - In addition to this guide, the TrialDirector Help system contains many feature overviews 
and task-specific topics that you can locate through the Contents or by searching on key 
words. To access the TrialDirector Help, open the Help menu in the program and click 
Contents.

• Training – Contact inData’s Training Department at 800-828-8292 or visit inData’s Web site to 
learn about our training classes.

• Technical Support – The Technical Support staff is available Monday through Friday from 9 
a.m. to 8 p.m. Eastern Time (excluding holidays) at 866-419-4298 to help you with any 
questions you have about TrialDirector.

• Recommended System Requirements
• Intel® Core™2 Duo Processor 2.0 Ghz (or better)

• Microsoft Windows®  7 operating system*

• 4GB System RAM 

• 256MB Dedicated Display Graphics Memory**

• 1280 X 1024 Display Resolution at 32-bit color palette

• 8x DVD Recordable Drive

• Sound Card and Speakers/Headphones (Required for audio functions)

*TrialDirector 6 can be run on both 32-bit and 64-bit versions of Windows XP, Windows Vista, and Windows 7 operating 
systems.

**Microsoft DirectX 10, DirectX 9, or OpenGL capable graphics card recommended. A Windows Experience Index 

graphics subscore of 4.0 (or higher) is recommended for best presentation performance.
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WHAT DO YOU WANT TO KNOW?

If you don’t have time to read this guide now, use the table below to find the information you’re 

looking for quickly. This Quick Start Guide provides basic information to help you get started, while 

the TrialDirector Help system includes detailed instructions and tips for using all features.

If this is your question.... ....then look here for your answer

What exactly do each of the categories – Case 

Library, Document Manager, Transcript Manager, 

and Coding – mean to me when I’m setting up a 

case in TrialDirector?

Guide: “Navigating in TrialDirector” on p. 5

Help: “Getting Started with TrialDirector”

See the “Navigating in TrialDirector” section.

How do I create a new case? Guide: “Creating and Organizing Your Case” 

on p. 7

Help: “Creating a New Case”

How do I get to the point where I can see 

documents and transcripts in my case?

Guide: “Adding Items to the Case” on p. 9

Help: “Loading Items into Your Case”

What do I need in order to have transcripts and 

video that work together? Help: “Loading Synchronized Transcripts”

How do I redact confidential information from my 

documents before presenting them in the 

courtroom?

Guide: “Annotating Images” on p. 28

Help: “Working with Annotations/Markups”

How do I find an item in my case or specific 

transcript text quickly?

Guide: “Finding Items and Transcript 

Testimony” on p. 18

Help: “Finding Items” and “Searching 

Transcripts”

How do I label an area in testimony that applies to 

a particular issue so I can easily refer back to it?

Guide: “Working with Issue Codes and 

Transcripts” on p. 22

Help: “Working with the Coding Database”

How do I print a list of exhibits in my case?

Help: “Creating Exhibit Lists”

What are Workbooks, and how do they help me 

organize my case and present it in court?

Guide: “Organizing Exhibits Using 

Workbooks” on p. 30

Help: “Working with Workbooks”

How can I present two documents side-by-side 

for comparison in court? Help: “Using the Presentation Zones”

How do I mark up and emphasize areas of exhibits 

during trial?

Guide: “Annotating Exhibits” on p. 34

Help: “Using Annotations in Presentation”

How do I play a video and scrolling transcript text 

when presenting my evidence?

Guide: “Presenting Video” on p. 34

Help: “Presenting Digital Video Transcripts 

(DVTs)”
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NAVIGATING IN TRIALDIRECTOR

The diagrams in this section explain the main features of the TrialDirector interface. 

To explore these features, open the sample case provided with the program.

Case Explorer
 5
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CREATING AND ORGANIZING YOUR CASE

Creating a Case

The first step in trial presentation is to create a case in TrialDirector.

1 Click on the   tool on the toolbar, or open the File menu and select Create a New Case…

2 Either accept the default location shown in the dialog box or browse to the location where the 

new case will be stored. By default, TrialDirector creates a Cases folder within the folder that 

contains the TrialDirector software.   

3 Click Next and enter information about your case.
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4 Click Next again. If you want, you can assign a password and other security to your case. See 

"Enable Case Security" in the Help system for additional information.

5 Click Create.

Tip
I f  you're using Tria lDirector as an add-in to  Summation iBlaze/Enterprise or 

Concordance, a  new case is created for  you when you act ivate the add-in.  See 

Appl icat ion Integrat ion in the Tria lDirector Help system for more informat ion.  

Opening an Existing Case 

1 Click the   tool on the toolbar, or open the File menu and select Open a Case.

2 Your case names will appear in the Select a case box. Click on the name of the case to select 

it, then click Open. (If the case you want to open does not appear in the list, browse to the 

location where the case is stored.)
8
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Adding Items to the Case
After you create a case, you will need to add items to it. The types of items that can be viewed in 

TrialDirector include:

• Images

• Photographs

• Native files (Microsoft Word, PowerPoint, Excel, PDF, and so on)

• Transcript text

• Video synchronized with transcript text

• Multimedia (animations, video and audio files)

To access these items from within TrialDirector, you must import them to your case. Adding items 

can be done by (1) dragging and dropping the item onto the Case Explorer tree, (2) using the Add 

Items dialog box or (3) scanning documents or photographs directly into TrialDirector. (For 

instructions on scanning documents directly into TrialDirector, see Loading Items Using a Scanner 

in the TrialDirector Help system.)

When adding items using drag-and-drop or the Add Items dialog box, you can add items one at a 

time or in batches, using a “load file.” Load files are usually provided by vendors or may be created 

using higher end scanning programs. A load file automates the process of adding items to your 

case. The following sections detail adding individual items, as well as using a load file.

Adding Items Using Drag and Drop
1 Arrange your Windows desktop so that you can view both the TrialDirector Case Explorer pane 

and the Windows Explorer (or My Computer) pane.

If the items are on a CD or DVD, copy them to the drive on which you want to store them before 

you load them into TrialDirector.

Tip
Within the case fo lder where the rest  of  your case informat ion resides, you may want to 

create folders for  the various types of  i tems you are adding. For example,  fo lders cal led 

Images, Video, Animat ions,  Nat ive F i les,  and Transcripts.  Doing so wi l l  make i t  easier  

for  you to locate and work with the f i les as your case progresses.

2 In the Windows Explorer (or My Computer) window, navigate to the location of the items you 

want to add to TrialDirector.

3 Select the item(s) you want to add to TrialDirector. Once they are selected, drag the items from 

the Windows Explorer (My Computer) window and drop them onto TrialDirector’s Case Explorer 

pane.

• Use CTRL+[click] to select multiple non-adjacent items or SHIFT+[click] to select multiple 
adjacent items.

• When adding single-page TIF images to TrialDirector, make sure to add only one document 
at a time. If you add more than one single-page TIF document at once, the individual 
documents will be added as a single multi-page document. (They can be separated later 
within TrialDirector, but it’s simpler to add them individually.) On the other hand, if you are 
adding multi-page TIF images, each file represents an entire document.
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• You do not need to be concerned with where to drop the items within the Case Explorer. 
TrialDirector determines the correct type of item and its folder in the Case Explorer.

4 Decide on the method you want to use for naming the files being added to TrialDirector. After 

you make your selections and confirm that the Page ID example accurately reflects what you 

want, click OK.

• In the following example, the item will be named JSS0001. If it is a multi-page document, 
each page is assigned the next unique number.

• Note that a Page ID example is displayed in the dialog box.

The items you added now appear in TrialDirector’s Case 

Explorer. In this example, the added items were images of 

documents, so they appear under the Documents folder in 

the Case Explorer.  Within the Documents folder, there is 

now an item for the two-page document (JS00001) and 

then, within that document, you see entries for individual 

pages of the document. You can now work with the 

document in its entirety or just with individual pages of the 

document depending on the task you want to perform.

Adding Items Using a Batch Load File

Accepted Batch Load File Formats

• OLL (TrialDirector®)

• DII (Summation®)

• LPT (IPRO®)

• TXT or DBF (Doculex®)

• LOG (Opticon® or generic load file)

The “name” of the load file reflects the 3-character 

file extension, e.g., Jones.OLL is a load file named 

“Jones” that was created specifically for 

TrialDirector. Jones.DII is a load file created to 

load images into Summation Enterprise/iBlaze.
10
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You can use the same drag-and-drop technique described previously with batch load files or you 

can use TrialDirector’s Document Import dialog box.

1 On the Documents menu, point to Import New Item(s) from... and click Batch Import File.

 

2 Click on the drop-down arrow to locate the file format of the load file you’re using. If necessary, 

click on the Browse button to navigate to the location of the load file. Once you have selected 

the file format and located the file, click Next.

3 The following dialog box provides options to set a standard rotation for images. 
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You can also adjust settings relating to Summation's DII file format:

• Replace @V Volume Label\Path with: ______ lets you replace the @V designation with a 
specific path where the images are stored.

• When Increment document page with suffix (IE:-0002) is checked, each page in the 
document will be numbered with the Doc ID number followed by a page suffix (i.e., -0002, 
-0003, -0004, and so on). Summation deals with documents on a document level where 
TrialDirector deals with documents on a page level. When you load documents using a 
Summation DII file, TrialDirector accommodates the document-level format by using page 
suffixes. If this option is not checked, the document will be added to TrialDirector using 
sequential numbering for each page. (For more information about working with  
Summation DII files, visit Summation's knowledge base.) Click Next.  

4 Click Import in the following dialog box. The progress bar will advance as items are loaded into 

your case.

5 After the batch processing is completed, click OK to view the items that were added to your 

case.

Adding Transcripts
TrialDirector can load transcripts (text-only transcripts or transcripts synchronized with video) in a 

variety of formats, including ASCII, AMICUS, DVT (Digital Video Transcript media), or a TrialDirector 

case file (CMS).

1 Click on the Transcript Manager tab at the bottom of the TrialDirector desktop.

2 Using the drag and drop technique described previously, drag and drop the transcript file onto 

the Transcript Explorer pane.

-or-

Click the Transcripts menu, point to Import Transcript(s) from…, and select the appropriate 

format from the list.
12
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3 The Import Transcript wizard opens. Click the Browse button and locate the transcript you want 

to load. When you select the transcript, the path and the selected transcript file appear in the 

Import Transcript wizard. Click Next.   

4 Review and modify the deposition information, if necessary. If you need to review the transcript, 

click Edit. If the information is correct, click Next.
 13



5 Verify that the pagination is accurate in the following dialog box. This is important in order to 

be sure that your page and line references are correct.

6 Click Import to load the transcript into your case.

7 When the progress bar reaches the end, click Next.
14



8 When the transcript import process is complete, you can click either OK to return to the 

Transcript Manager window, or Again to load another transcript.  

If the check box next to Automatically index new transcript(s) is checked, the transcript will 

be indexed before it is added to the Transcript Explorer. If the check box is not checked, you 

can index transcripts later. Indexing transcripts is important. See “Indexing Transcripts” in the 

TrialDirector Help system for more information.

Indexing Transcripts
If you choose not to index the transcripts when they are loaded, you can index them later from 

within the Transcript Manager. To do so:

1 In the Transcript Manager, open the Transcripts menu and select Index Transcripts….
 15
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2 The transcripts requiring indexing are listed. Select one or more transcripts (or click Select All 

to choose all of the transcripts). Then click Next.

3 Select Index and allow the program to index the transcripts.

4 When indexing is completed, click OK. Now you will be able to search the contents of the 

transcript as well as view the list of words contained within the transcript.

See “Loading Items into Your Case” in the TrialDirector Help system for more information on all of 

the methods for adding documents and transcripts to your case.



PREPARING FOR TRIAL

TrialDirector gives you the option to assign issues (such as elements of proof, defenses, and 

specific witnesses) to documents, transcript testimony and other pieces of potential evidence in 

your case.

You can search document indexes, the content of documents (if they were run through a full-text 

OCR process), and testimony. Attach memos and notes to items in your case. Add highlighting, 

redactions, and other markups (annotations) to images in your case in order to focus on key points 

you may want to pursue. Markups can also be displayed during presentation in the courtroom, or 

you can create markups “on the fly” in Presentation mode. (For suggestions on using markups 

during your presentation, see the Present ing at  Tria l  section of this guide.)

Understanding Coding
Information about the documents in your case may be imported into TrialDirector from other 

database programs, such as Summation Enterprise or iBlaze. You can also enter information 

directly into TrialDirector’s Coding tab. Certain fields from the Coding tab can be synchronized with 

the items listed in the Document Manager and Case Explorer using TrialDirector’s synchronization 

feature.

Entering a brief description for each item in your case makes it easier to locate those documents 

within your case. You can also use the database to sort the information chronologically, for 

example, or perhaps by author. Since entering information about your documents (also known as 

“coding”) can be time-intensive, you may want to limit coding to those items that are going to be 

used at trial.

Issue-Coding Many litigators use issue coding to help categorize the evidence in their cases, even 

if they don’t refer to the process as “issue-coding.” For example, you may attach sticky notes or 

scribble a word or two in the margin of transcripts in order to remind you of the topic the testimony 

relates to. You may have several file folders on your desk, each one of which relates to a particular 

topic or element of proof or defense or witness. As you come across documents and testimony that 

relate to any of these, you might copy the document or transcript page and toss it into one or more 

file folders, depending on your organizational system. You can do this electronically in TrialDirector, 

color coding excerpts of testimony, annotating documents, and collecting documents and 

testimony excerpts in workbooks.
 17



Finding Items and Transcript Testimony
Before you begin coding and using other methods to organize your case, it's helpful to understand 

the ways you can find items and specific transcript testimony.

Finding Items in Your Case
It's easy to locate items in the Case Explorer using the Find tool. You can search for any of the 

following criteria:

• Item ID number (e.g., DEMO00002)

• Description (a brief “shorthand” title for the item to help you identify it quickly during trial)

• Exhibit No. (deposition exhibit number)

• Trial Exhibit No. (trial exhibit number)

• Notes & Memos (the contents of the Summary field, if data is imported from Summation. 
Alternatively, you can easily add memos to any of the items in your case.)

1 Click on the   tool on the toolbar in the Case Explorer or Document Manager, or click on the 

Edit menu and select Find…

2 In the Find dialog box, enter the word you want to look for and the other criteria for your search. 

It is not necessary to use a wildcard character. So searching for anim finds animation, animated, 

animations, animal, animals, etc.

To view each item one at a time, select Browse Results Individually. 

Click Find First to display the first item. Click Find Next to continue viewing each of the other 

items found as a result of the search.
18



To view all of the items at once, select Send Results to Workbook. Click Find All to run the 

search. A Search Results workbook is created in the Workbook Explorer section of the Case 

Library. From there, you can view all of the items located as a result of your search.

TrialDirector gives you several methods to locate testimony within transcripts. You can search the 

Word List for each of the transcripts. You can also search within a single transcript for a word or 

phrase or search across multiple transcripts.

Opening a Transcript and its Word List

1 Click the Transcript Manager tab to display the transcript workspace.

2 In the Transcript Explorer, expand the transcript you wish to work with. (Click on the  to the 

left of the transcript name.)

The following items may appear under your transcripts:

• ASCII Transcript for [deponent’s name]

• Audio/Video for [deponent’s name] (if a video version of the transcript has been loaded into 
your case for the selected deponent)

• One or more Clips (each clip contains one or more segments of synchronized text and 
video)

• A Virtual Clip (the synchronized text and video for the entire transcript)

• Exhibits attached to the transcript

• Issue Codes and Annotations

3 Double-click on ASCII Transcript for [deponent’s name]. The transcript opens on the 

desktop.
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4 To view the Word List, with the transcript open on the desktop, click on the View menu and 

select Word Index.

5 When you locate a word that interests you, you can click on the page:line reference(s) adjacent 

to the word to jump to that point in the transcript and the synchronized video (if any).

6 TrialDirector takes you to that location within the transcript and, if the transcript has associated 

video, the Multimedia Player displays the associated segment of the video. To play the video, 

click on the PLAY button. To stop the video playback, click on the STOP button.

Searching One or More Transcripts

1 With a transcript open on the desktop, click the Search tab at the top of the desktop.

2 Enter the term(s) you want to find in the Search for: box.

Use the wildcard character * to locate variations of a term. For example, search for "claim" and 

you will only find where that exact word appears. Search for "claim*", and you will find all 

occurrences of claim, claims, claimed, claiming.
20



3 In the Search within box, select whether you want to search all of the transcripts, only selected 

transcripts, or only the current transcript.

4 In the Search method box, choose whether you want to find the exact word or phrase entered 

in the Search for: box or whether you want to develop a compound search using AND or OR.

5 After your search criteria are specified, click on the Search button. A list of the transcripts 

containing the search term or phrase appears on the screen. The number of matches is 

displayed to the right of each transcript name.

• Click on the  sign for each transcript to view a list of the page:line citations.

• Click the   next to each page:line reference to view the question-and-answer pair in which 
the search term appears.

• Click on the line of text adjacent to the page:line citation to jump to that location in the 
transcript.
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Working with Issue Codes and Transcripts
Before you assign issue codes to transcript testimony, you’ll want to begin by creating the issue 

code list.

Tip
Keep your l ist  of  issues s imple.  The more complex an issues l ist  becomes, the more 

diff icul t  i t  is  to use.

Managing Issue Codes

1 In the Transcript Manager, open the Transcripts menu and select Manage Issue Codes….

2 In the dialog box, click the New button.

3 Replace the text “New Issue Code” with a short title for the issue you want to add.

4 To change the color of the highlighting that will appear in the transcript for the new issue, click 

on the color box. A spectrum dialog box opens from which you can select a color.

Tip
Avoid using dark colors for  issue codes or  you won’t  be able to v iew the test imony 

through the issue code h ighl ight ing.

5 To change the function key associated with the issue, click on the F# and select the new 

function key from the list.

6 Continue adding issues as desired. When you are finished, click Exit.
22



Assigning Issue Codes to Testimony

1 With a transcript open in the Transcript Manager, locate and highlight testimony to which you 

would like to assign one or more issue codes.

2 Right-click on the selected text, then select Issue Code/Annotate Selected Text. The issue 

code list opens.

3 Click on each of the issues that you want to assign to the text. Click Apply, then Exit. When 

you assign issues to text, two things happen:

• The transcript is highlighted to reflect the color of the issue you assign. If you assign more 
than one issue to the same text, only the color of the last issue code appears on the screen.

• In the Transcript Explorer, the text citation appears under Issue Codes and Annotations for 
that witness, organized according to issue.
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Printing Issue Code Reports

1 From anywhere in TrialDirector, open the File menu and click Print.

2 Under Print What?, click on the drop-down arrow and select Issue Codes Report (Detailed).

3 Customize the Issue Codes Report using any of several settings. Group by transcript name or 

by issue. Include all issues or only selected issues. Display the related Q&A pair or only a 

selected number of lines. Print the issues for all transcripts, the current transcript, selected 

transcripts or transcript within a specified date range.
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4 Click Print. The report is compiled and printed by TrialDirector. Depending on the selections 

you made in the Print dialog, your issue report may look like the following example:
 25



Working with Video Clips
Creating a video clip is easy in TrialDirector. A video clip consists of one or more segments taken 

from a synchronized transcript, such as a digital video transcript (DVT). By combining several 

segments into a single clip, you can play relevant testimony sequentially, without interruptions such 

as long pauses, objections or irrelevant testimony. In this section, we’ll show you how to create a 

video clip using one method. TrialDirector gives you the flexibility to create clips using a variety of 

other methods as well. Refer to “Working with Transcript Clips” in the TrialDirector Help system for 

more information on creating and managing clips.

Creating a Video Clip with Multiple Segments

1 Select the Transcript Manager tab.

2 Either open the ASCII transcript for a particular deponent or run a search as described 

previously. If the transcript is linked to synchronized video, the video will appear in the 

Multimedia Player in the upper right corner of the Transcript Manager.

3 Locate the lines of text you want to capture in the clip. Highlight the lines, right-click and select 

Create New Clip from Selected Text….

4 If the highlighting covers objections in the testimony, you will see the following dialog box, 

which gives you the opportunity to edit the clip so that only pertinent testimony is played:
26



5 Move to the next segment you want to add to the clip. Highlight the segment, right-click, and 

select Add Selected Text to Clip [clip identifier].

6 To create a new clip rather than a segment, select Create New Clip from Selected Text….

Tip
In Presentat ion mode, you can move from cl ip to c l ip easi ly.  Be conservat ive when 

adding segments to c l ips so that you can easi ly  exclude a piece of  test imony should i t  

not  be necessary to p lay i t ,  or  should opposing counsel  object to i ts use at  t ria l .  

Remember,  a c l ip plays al l  segments successively as one cont inuous chain.

All clips are displayed in the Transcript Manager and within the Transcripts section of the Case 

Library, organized according to deponent or witness. You can drag and drop clips into a workbook 

when organizing your evidence or preparing for trial.
 27



Annotating Images
TrialDirector offers a variety of helpful tools to use for marking up images. You may choose to apply 

annotations (also referred to as “markups”) before you ever get to the courtroom; this is referred 

to as “pre-treating” the images. You may also choose to wait until you present images in the 

courtroom and mark them up in real time. Or you may use a combination of these techniques to 

create an effective trial presentation.  

Adding Annotations to Images
The annotations that can be added to the images in your case are:

• Highlighting (in multiple colors)

• Redactions

• Arrows (in multiple colors and widths)

• Text

• Lines (in multiple colors and widths)

• Sticky Notes

• Boxes (in multiple colors and widths)

• Circles (in multiple colors and widths)

• Stamps (which can be customized)

• Free-hand drawing

• Exhibit stamps

1 Click on the   tool on the toolbar OR select Show Image Annotation Toolbar from the 

Documents menu. The annotation toolbar is displayed on the desktop.

2 Select the annotation tool you wish to use. Then, if applicable, select the color of the tool from 

the color bar.

3 Draw the annotation on the image.

When you create the annotation, it appears on the page as shown below. (The following 

example was created using the Highlight tool, with the color set to yellow.)
28



To delete or move the annotation, click on the  tool on the toolbar, then click on the 

annotation. Notice the outline around the annotation. When you see this outline, your mouse 

pointer will appear as a . At this point, you may move the annotation or delete it by clicking 

on the Delete key on your keyboard OR by right-clicking on the selected annotation and 

selecting Delete from the shortcut menu.

To change the color of the annotation, select it (as shown above) and right-click on the 

annotation. Select Set Background Color, and the following dialog box opens. Choose the 

color you wish to use and click OK.

For more detailed information on adding annotations, see “Working with Annotations/Markups” in 

the TrialDirector Help system.
 29



Organizing Exhibits Using Workbooks
The Workbooks Explorer is a convenient and flexible way to organize and work with the exhibits in 

your case. When you first create a case, three workbooks are created for you: Search Results, Trial 

Exhibits and Witnesses. You can create additional workbooks as needed for your case. Use 

workbooks to select groups of items for printing, to create exhibit outlines (see below), to display 

exhibits at trial, and to easily create a PDF file of the images in the workbook, among other things. 

Basic information is included below. See “Working with Workbooks” in the TrialDirector Help 

system for detailed information.

Creating a Workbook

1 Click  on the toolbar.

TrialDirector creates a workbook with “New Workbook” selected in Workbooks Explorer so you 

can change the name.

2 Type a name for the workbook.

Adding Items to a Workbook
• To add an item to a workbook, simply drag and drop it from the Case Library.

• To select multiple items in the Case Library to add to a workbook, hold the CTRL button down 
as you click on the items.

• To select multiple adjacent items, hold the SHIFT button down, click on the first item in the 
group, then click on the last item in the group.

Tip
Continue to hold down the CTRL or  SHIFT button as you drag the i tems to the Workbook 

Explorer and drop them on the desired workbook.

Setting the Workbook Color or Type
To assign a colored icon to the workbook, right-click on the workbook name, point to Select 

Workbook Color or Type, and then click a color. Or, you can designate the workbook as a Carousel 

or as a MultiPlayer Workbook. These special types of workbooks are designed for presentation. For 

more information, see “Using MultiPlayer Workbooks” or “Using Carousels” in the TrialDirector Help 

system.
30



Creating an Exhibit Outline from a Workbook
An Exhibit Outline is a printed summary of the contents of a workbook. The exhibit outline displays 

the item ID and notes, an image of the item, and a barcode that represents the item. The barcodes 

can be used to quickly display the item during trail. Exhibit outlines are exported to a Microsoft 

Word format.

1 Right-click on the workbook from which you want to develop an Exhibit Outline.

2 Choose Send Workbook contents to Microsoft Word Exhibit Outline from the shortcut menu.

3 The Exhibits Outline can be edited using Word.
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PRESENTING AT TRIAL

As an experienced litigator, you know that two of the keys to effectively telling your case’s story in 

the courtroom are organization and the ability to respond quickly to changing events. TrialDirector 

helps you with both.

TrialDirector’s Presentation mode starts with a blank screen and a toolbar along the bottom of the 

blank screen. Your exhibits are displayed on the screen without the interference of menus or other 

“noise” on the screen to distract jurors. The toolbar can be customized to suit your presentation 

style, and, if you wish, it can be hidden completely until you are ready to use it. (For more 

information, see “Presentation Preferences” in the TrialDirector Help system.)

Tip
Consider connect ing and enabl ing dual  displays when you present your case (such as a 

laptop screen plus an external  monitor,  or  a laptop screen and a projector) .  This makes 

presentat ion much easier  because you can “drive” the presentat ion from your laptop 

whi le the jury only sees the Presentat ion display on the external  monitor  or pro jector.  

See “Using Presentat ion Preview” and “Dragging and Dropping I tems onto the 

Presentat ion Display” in the TrialDirector Help system for more informat ion.

Retrieving exhibits in Presentation mode can be accomplished in a number of ways, two of which 

are covered here. For more information on other methods, see “Displaying Items in Presentation 

Mode” in the TrialDirector Help system.

Retrieving an Exhibit Using an ID

1 From the main TrialDirector window, click Presentation on the toolbar.

2 After Presentation mode opens, simply type the Item ID number, Exhibit Number, or Trial Exhibit 

Number (assigned in the Document Manager or Coding tabs).

As you type, the number appears in the lower right corner of the display area.

3 Press ENTER.
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Retrieving an Exhibit Using the Toolbar
The Navigation Tools on the left side of the Presentation Toolbar enable you to navigate through 

the items in your case in several ways.

To load an item using the toolbar:

1 Select the appropriate workbook, then select the item you want to load.

2 Click the green button to the load the item.
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Annotating Exhibits

Once an exhibit or other item is loaded in Presentation mode, you can use many different tools 
to annotate and emphasize it.

Check www.indatacorp.com for tutorials on using these tools.

Presenting Video
You can present synchronized video transcripts, such as Digital Video Transcripts (DVTs) of 

depositions, surveillance video, and other video footage to captivate the jury as you present your 

case. Load video the same way you load documents and other items (such as by entering an ID, or 

using the Navigation Tools on the Presentation Toolbar). Then, use the tools to annotate and 

emphasize areas in the running video. For example, consider:

The Projection Zoom tool (Callout Zoom Tools) to enlarge an area and draw attention to it, 

such as a license plate or a deponent's eyes.

The Blur tool (Annotations) to make a person or other identifying information not applicable 

to your case unrecognizable.

The Ellipse tool (Annotations) to circle the area where you want the jurors to focus their 

attention.
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When you present a clip from a DVT, the transcript text scrolls as the video plays.  

Press CTRL + TAB to open the layout options to select a different layout, as shown:

Setting Preferences
Many settings in Presentation Preferences influence appearance and behavior. To open 

Presentation Preferences, click the Presentation menu button  at the far left end of the toolbar, 

and then click Preferences.
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YOU’RE ON YOUR WAY…

This guide was intended to help you become accustomed to some of the popular features in 

TrialDirector, but many more features exist. When you are comfortable with the basics, you’ll want 

to look into other topics in the TrialDirector Help system, such as:

• “Working with the Clip Editor” to revise starts and stops to be exactly where you need them.

• “Using the Presentation Zones” to enable side-by-side comparisons of documents.

• “Saving and Loading Stages” to preserve the dynamic layout of your presentation and all 
annotations.

• “Using Pack-N-Go” to put a copy of your TrialDirector case on a laptop.

• And much more….
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